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Available online at https://www.nifc.gov/PIO_bb/docs.html          Updated Feb 26, 2019 

 
INFO CENTER HOURS:      
 
BREAKFAST:  LUNCH:  DINNER:  SHOWERS: 
 
DAILY SCHEDULE 

 
  AM BRIEFING 
 
 

PIO AM MEETING   
 

 
DISTRIBUTE AM UPDATE 

 
 
  PRESS CONFERENCE 
 
 
  PIO COOPERATOR CALL 
 
 
  COOPERATORS MEETING 
 
 
  C&G MEETING 
 
 
  PRE-PLANNING MEETING 
 
 
  PLANNING MEETING 
 
 
  PM BRIEFING 

 
 
DISTRIBUTE PM UPDATE 
 
 
COMMUNITY MEETING  

 
 
  PIO PM MEETING 

 

NAME O-# 
 

INCIDENT NAME INCIDENT # 
 

HOST UNIT ACCT CODE 
 

PIO Briefings 
 

Situation: Here’s what I think we face. 
 

Task: Here’s what I think we should do. 
 

Intent: Here’s why I think we should do it. 
 

Concern: Here’s what we should keep 
our eye on because if that changes, 
we’re in a whole new situation. 
 

Calibrate: Now talk to me.  Tell me if you 
don’t understand, cannot do it, or see 
something I do not. 

PIO Pulse Check 
 

What have I missed? 
 

What is unclear? 
 

What has to change?  
 

Did I learn something others should 
know about?   
 

Who’s acting if lead is unavailable? 
 

Do PIOs have regular communication with 
ICP? 
 

Are PIOs are aware of incident-within-
incident procedures? 
 

Regular communication with host unit / key 
contacts? 
 

Adequate meals / showers / breaks / work-
rest ratio? 
 

Are we learning from our mistakes? 

 

https://www.nifc.gov/PIO_bb/docs.html
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CALL-OUT / CHECK-IN / SET-UP 
 

UPON CALL-OUT 
- Notify Supervisor 
- Obtain Resource Order 

- Incident name?  
- Report location? Report date and time? 
- Are rental car, laptop, camera, printer,      

radio and/or cell phone authorized?  
- Contact number for lead PIO and/or     
  Expanded Dispatch at the incident? 
- Copy of Resource Order to home unit 

- Obtain Travel Authorization 
- Call Lead PIO with Est. Time of Arrival 
 
LEAD IMT PIO 
- Call IC for initial briefing 
- Call unit PAO to assess needs  
- Submit pre-order for PIOs 
- Bring or ship team PIO supplies 
- Update IMT website with current 

assignment info 
 
ALWAYS PACK  
Max weight 65 lb total - label everything 
- Resource Order  
- Red Card 
- Federal and/or Team ID 
- Taskbook 
- Wildland Fire Incident Mgmt Field Guide 
- Incident Response Pocket Guide (IRPG) 
- Cell phone and charger (if authorized) 
- Home Unit Dispatch Phone # 
- Home Unit Timekeeper Phone # & Fax # 
- Full PPE 
- Personal Gear 
- PIO Home Unit or Travel Kit 
 
REQUIRED PPE (<20lb)  
- Nomex pants & shirt 
- 8” Leather fire boots & spare laces 
- Helmet & Headlamp 
- Goggles 
- Gloves 
- Fire shelter 
- Ear plugs 
- Water bottles 

 
PERSONAL GEAR (<45 lb, soft-sided bag) 
- Matches (can’t take on an airplane) 
- Signal Mirror 
- Compass 
- Jackknife (don’t pack in carry on bag) 
- Parachute cord 
- Granola bar 
- First aid kit 

PERSONAL GEAR (continued) 
- Space blanket 
- AA batteries 
- Hat 
- Sunglasses / spare glasses 
- Prescriptions  
- Sunscreen 
- Bug spray 
- Bandana 
- Rain gear 
- Toiletries & flip flops 
- Small towel 
- Flashlight 
- Extra clothing (cotton) 
- Warm jacket, hat, gloves 
- Alarm clock & AAA batteries if needed 
- Tent 
- Sleeping Bag & Pad 
- Handheld Radio 

 
PIO TRAVEL KIT 
- Magnetic “Fire Information” signs  
- “Fire Information” Banner  
- PIO nametag 
- Jumpdrive with templates and examples 

https://www.nifc.gov/PIO_bb/docs.html 
- Digital camera (if authorized) 
- extra batteries and memory cards 
- download cable and charger 

- Laptop computer & cables (if authorized) 
- GPS & cables (if authorized) 
- Portable printer, cables, and ink (if 

authorized) 
- Folder for documentation 
- Light duty staple gun and staples 
- Staple puller or pliers 
- Masking tape or painter’s tape 
- Push pins 
- Pens and pencils 
- Permanent markers (black and red) 
- Highlighters 
- Paper clips 
- Rubber bands 
 
PIO HOME UNIT KIT 
- PIO Travel Kit Items 
- Unit Logs 
- Crew Time Report (CTR) Book 
- General Message Forms 
- Request for Recognition Forms 
- Phone / Answering Machine 
- Bulletin Boards  
- Clear plastic / trash bags to cover boards 
- Laptops Printer / Scanner/ Copier /Fax  

https://www.nwcg.gov/sites/default/files/products/pms210.pdf
https://www.nwcg.gov/sites/default/files/products/pms210.pdf
https://www.nwcg.gov/sites/default/files/products/pms461.pdf
https://www.nwcg.gov/sites/default/files/products/pms461.pdf
https://www.nifc.gov/PIO_bb/docs.html
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PIO HOME UNIT KIT (continued) 
- Ink for Printer / Copier / Fax 
- Router box / extra network cables 
- Surge strip / extension cords 
- Copy Paper / Colored Paper  
- File Box  
- Manila and/or Hanging Folders 
- 2-Pocket Folders  
- Accordion  Folders 
- Clear Sleeves / Laminating Pages 
- Flip Charts / Markers / Easel 
- Dry Erase Board / Markers 
- Blank CDs / DVDs and Cases 
- 6”x9” Steno pads with rings on top 
- Calculator 
- Binder Clips 
- Post-it Notes 
- 3-Ring Binders / 3-Hole Punch 
- Laser Pointer 
- Duct Tape / Blue Tape / Scotch Tape 
- Stapler / Staples / Staple Puller 
- Envelopes & Stamps 
- Large manila envelopes 
- Scissors 
- Cardstock or Photo Paper 
- Certificate Holders 
- Portable TV / Radio 
- Handheld people counter / clicker 
- AA batteries 
- Trash bags 
- Calendar 
- Interagency Standards for Fire & Fire 

Aviation Operations (the “Redbook”) 
- National Mobilization Guide 
- GACC Mobilization Guide 
- GACC Media Guide 
- Local unit/state highway maps 
- Team templates 
- Incident-Within-An-Incident Protocol 
- Hand tool 
- Water  
- Hand Sanitizer 
- Tissues / Paper Towels 
- PPE for Media 
- MREs  
- Cooler 
 
CHECK-IN 
- Check-In (resource order & red card) 
- Report to Lead PIO 
- Ground Support 
- Communications (clone radio, batteries) 
- Supply (hand tool, cooler, etc.) 
- Training Specialist 
- Set up Tent 

 

FIRST OPERATIONAL PERIOD 
- PIO Briefing 
- Call key contacts: PAO, JIC, Media, etc. 
- Set up daily PIO Cooperator call (Ex. 

freeconferencecall.com) 
- Order PIOs via General Message 
- Order supplies via General Message 
- Newspapers  
- Yurt / Lights  
- Tables / Chairs 
- Phone / Answering Machine 
- Laptop / Network Connections 
- Printer / copier / fax machine 
- Bulletin Boards  

- Map Request via General Message  
- Specify quantity, type (including PDF), 
and date and time needed 
- Assign 1 person to pick-up 

- Coordinate with Liaison Officer  
- Key Contacts, Etc. 

- Set up workspace (phones, etc.) 
- Set up thumbdrive with templates 
- Set up e-mail, Inciweb, Twitter, etc. 
- Set up fire info phone #s and voicemail 

for public and media 
(Ex. https://www.google.com/voice) 

- Set up Google alerts (google.com/alerts) 
- Prepare and distribute daily update 
- Establish info center location & hours 
- Determine trapline locations 
- Assess taskbook needs 
- Establish Doc Box 
 
ORDERING PIOs 
- Order via General Msg – Print Legibly 
- Specify quantity, qualification & report 

date/time needed 
- Specify if rental car, laptop, cell phone, 

camera and/or printer are authorized 
- If name request, specify name in ROSS, 

qualification, phone number(s), home 
unit id, and home unit dispatch & phone.  

 
DOC BOX LABELS 
- Community Relations / PSAs 
- Closure Orders / Restrictions 
- Info Summary / Comm Strategy 
- Media Log / Key Contacts / Traplines 
- Newspaper Clippings 
- Press Releases / Daily Fire Updates 
- Public Meetings / Briefings 
- Special Events / Tours / VIP Visits 
- Thank You Letters 
- Web Pages / Videos / Photos 
- Unit Logs 
- General Messages 

https://www.google.com/voice
http://www.google.com/alerts
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IN-BRIEFING 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 

 
 
Review: 

 Incident Action Plan (IAP) 

 ICS-209 , Incident Status Summary 

 Delegation of Authority (especially review expectations for incident information protocol) 

 Transition plan 

 Wildland Fire Decision Support System (WFDSS) 

 Fire Management Plan / Fire History 

 List of current / ordered resources 

http://wfdss.usgs.gov/wfdss/WFDSS_Home.shtml
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IN-BRIEF Date/Time 

Incident Name Complexity  

IMT Name IC Name 

Ownership Jurisdiction 

Location 

 

County 

Legal Coordinates 

Cause Elevation 

Reported by Reported When 

Date of Origin Time of Origin 

Estimated Size Estimated % Containment 

Est Containment Date/Time Est Control Date/Time 

Injuries   Cost 

Resources Responding (show how many) Total # Personnel 
          Type 1 Engines            Type 1 Handcrews             Type 1 Helicopters 

          Type 2 Engines            Type 2 Handcrews            Type 2 Helicopters 

          Type 3 Engines             Modules            Type 3 Helicopters 

          Type 4 Engines            Overhead            Air Tankers 

          Type 5 Engines            Dozers            SEATs 

          Type 6 Engines            Water Tenders            Retardant Drops 

          Type 7 Engines           Other            Water Drops 

Values at Risk 

 

 

Structures Threatened:                    Damaged:                 Destroyed: 

Evacuations 

 

 

Restrictions 

 

 

Closures 

 

 

Cooperators 

 

 

 

Fire Behavior 
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Fuel Type 

Topography 

 

 

Weather 

 

 

 

 

Growth Potential 

 

Current Status 

 

 

 

 

Current Actions 

 

 

 

 

Planned Actions 

 

 

 

 

 

Smoke 

 

 

Socio/Political Concerns  

 

 

 

Other Current Incidents in the Area 

 

 

Significant Past Incidents 
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QUESTIONS FOR HOST UNIT PUBLIC AFFAIRS OFFICER (PAO) 
Always Check In Regularly With the Local PAOs for All Agencies on the Delegation of Authority 

 
Management, Leadership and Decision 
Making Unified Command? 
 
 
Incident Info Center Location, who will 
manage, staffing, hours, phone numbers?  
 
 
Incident Info Field Operations Location, 
agencies involved, who will coordinate? 
 
 
Logistical Support What is computer, 
phone, cell, e-mail capacity of incident?  
Laminator, LCD projector, printer, fax, etc.? 
Phones at ranger station, EOC, etc.? 
 
 
Daily Fact Sheets Who is responsible, 
how often, who will prepare, what template 
will be used, which logos to use? 
 
 
Press Releases on Fire Activity What 
template will be used, who approves, etc.? 
Translations? 
 
 
Contacts Email and phone lists (Agency, 
Media, Elected Officials, Community, etc) 
Who will send out?   
 
 
Sensitive Topics What are they?  Who will 
handle? 

Community Contacts Evacuation centers, 
trap lines, etc.? When, where and how 
often? Which ranger stations should be on 
the trapline? Local translators available? 
 
 
Website Inciweb or other?  Use of social 
media? Who will coordinate, update, how 
often?  Local unit webmaster?  Passwords? 
 
 
Community Meetings Location, format, 
how often? Who will manage / conduct? 
Role of the agency official?  Translators? 
 
 
Media/Press Conferences Media 
coordination, how often, who will conduct, 
who will send information to media?   
 
 
Elected official coordination, meetings 
and onsite tours of the incident.  Who 
will contact and coordinate? 
 
 
Documentation of the Incident Specific 
needs? Who will monitor media coverage 
TV, radio, newspaper, web, social media?  
 
 
Incident Communications Strategies 
Protocol for release of critical info? Leads & 
Deputies? 
 
 

 

 
CHECKLIST OF ROLES TO DISCUSS WITH EMERGENCY OPERATIONS 

CENTER (EOC) or JOINT INFORMATION CENTER (JIC) PIO 
https://bit.ly/IMT-LocalPIORoles 

Local PIO Resources 

Name Phone Qual Availability 

    

    

    

    

    

http://bit.ly/IMT-LocalPIORoles
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PAO / PIO ROLES AND RESPONSIBILITIES 
 

Host Unit PAO 
 Prepares / updates home unit emergency communications plan prior to incident 
 Through the agency administrator (AA), and in discussion with the incident lead PIO, assigns 

info objectives and duties to the incoming PIO.  Assigned PIO duties may include part or all of 
the emergency info responsibilities such as: community info, info center management, media 
contacts, web updates, daily info sheet updates, interagency info sharing, media briefings, the 
use of team and agency logos 

 The agency Public Affairs Officer (PAO) usually retains some or all duties that directly support 
the AA such as: congressional and other elected official contacts, agency lead on fatalities or 
serious accidents during the initial stages, spokesperson on issues related to agency policy, 
announcement of the cause of fires, media conferences. 

 
Team PIO 
 Designs / executes an incident info 

strategy to achieve the AA’s assigned 
objectives. 

 Orders, assigns duties, and evaluates 
assistant PIOs working for IMT. 

 Manages incident-within-an-incident in 
close coordination with PAO. 

 Follows AA’s protocol for fatalities and 
serious accidents. 

 Conducts community meetings 
requested by AA. 

 Develops / implements strategy to keep 
incident personnel informed. 

 Advises IC on emerging issues and 
communication strategies. 

 Coordinates with other incident PIOs in 
the area including JIC. 

 Demobilizes PIO personnel and 
resources. 

 Prepares transition plan and incident  
PIO narrative. 

 
 
Area Command 
 Develop / execute info strategy designed to meet AA’s objectives as outlined in the Delegation 

of Authority. 
 Coordinates with unit PAO to reduce duplication of efforts and strengthen relationships. 
 Inventories personnel assigned within the command. 
 Assists in filling PIO resource orders as needed by PIOs within the Command. 
 Manages an info center that meets AA objectives. 
 After discussions with Lead PIOs and ICs, reassigns info resources as needed within the 

command. 
 Orders, assigns work, and evaluations PIO personnel working for AC. 
 Supports incident PIOs in obtaining info/resources they need to accomplish their mission (ie. 

road closure / evacuation info) 
 Supports AC info needs. 
 Provides media with summary briefings on incidents within the command. 
 Facilitates info sharing / issue identification among incident PIOs within the command. 

Leader’s Intent for PIO Staff 
Be Safe – Be Professional –  
Maintain Positive Relations  

 

DUTY  
- Provide clear, accurate, timely info to 

internal and external audiences.  
- Maintain situational awareness. 
- Maintain incident documentation. 
 
RESPECT 
- Demonstrate courtesy and tolerance. 
- Work as a team for the greater good. 
- Honor commitments, deadlines, and 

others’ time. 
 
INTEGRITY 
- Know yourself and seek improvement. 
- Seek and accept responsibility for your 

actions. 
- Resolve issues at lowest level. 
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JOINT INFORMATION CENTER (JIC) ROLES AND RESPONSIBILTIES 
 https://bit.ly/NRT-JICModel 

Lead PIO: 
• responsible for managing the JIC; 
• serves as advisor to IC/UC; 
• provides overall communication policy direction; 
• recommends and develops strategy for messages, briefings, and news releases; 
• obtains approval from those in authority before releases are made; and 
• conducts JIS/JIC briefings (live or virtual) to update staff regarding Incident Command activities. 
 
Information Gathering: 
• Response Partners – Coordination with supporting response agencies and their PIOs at EOCs, 
incident command posts, and other locations to gather information on the incident. 
• Media Monitoring Analysis/Rapid Response – Entails reviewing media reports for accuracy, content, 
and possible response. 
• Research and Writing:  
- Products – Writing materials such as media releases, fact sheets, flyers, etc. 
- Graphics Support – Entails designing layouts, developing PowerPoint presentations, and creating 

graphics for a range of materials (e.g., newsletters, flyers, etc.). 
• Audio-Visual: 
- Broadcast Operations – Entails developing video documentation, special productions, remote live 

interview feeds, and logistical support of public meetings and presentations. 
- Photo Video – Entails providing still photography documentation to support print and internet 

media needs, and video documentation to support broadcast media needs. Also includes 
collecting materials for agency archives. 

 
Information Dissemination: 
• Briefing/Special Events – Entails handling events such as news conferences, media briefings, VIP 
visits, and tours for senior officials of affected areas. 
• Media Relations: 
- News Desk – Serves as the primary point of contact for the media. 
- Spokesperson – Prepares and conducts regular news briefings and conferences. 

• Web Support – Entails creating and maintaining web pages and blogs containing information about the 
incident for use by the public and the media. 
• Public Inquiries – Entails responding to questions from citizens, making referrals, and developing a log 
of telephone calls, e-mails, etc., containing names, addresses, the type of calls, and any necessary 
follow up actions. 
 
Operations Support: 
• Special Needs/Multilingual – Entails providing language translation and other services to ensure 
appropriate and timely information reaches those in the affected areas with special needs. 
• Facility Support – Coordinates with the JIC Facility Liaison to maintain and support the JIC operations 
concerning the facility and resources. 
 
Liaison: 
Provides a coordinated two-way communication link with key program areas and other entities involved 
in the response and recovery operation (e.g., elected officials, community leaders, VIPs, and other 
governmental and NGO support agencies). 
 
DEMOBILIZING THE JOINT INFORMATION CENTER (JIC) 
• prepare a comprehensive deactivation news release for lead-agency approval and distribution; 
• notify community, media, agency communications managers and local officials about closing and 
provide regional contact information; 
• provide casebooks to communication managers whose organizations will assume responsibility for 
ongoing information; 
• complete an after-action report and participate in evaluation discussions;  
• return borrowed equipment and supplies; 
• inventory equipment and supplies; and  
• replenish “Go Kits” as necessary.

http://bit.ly/NRT-JICModel
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COMMUNICATION STRATEGY 
 
SITUATION / SOCIO-POLITICAL CONCERNS 
 
AUDIENCE 

- Local communities / businesses 
- Visitors / recreationists 
- Media 
- Elected officials  

 

- Agency Personnel 
- Incident Personnel 
- Partner Agencies  
- Nearby Incidents 

 
OBJECTIVES 
- Keep internal and external audiences informed with accurate, timely information. 
- Be the first and best source of information about the fire; Update information frequently. 
- Address rumors to prevent confusion. 
- Accommodate media requests quickly and safely. 
- Communicate consistent messages about the benefits and risks associated with wildland fire. 

- Collaborate with interagency and community partners for maximum efficiency and effect. 
 
STAFFING 
Current     Target 
 
KEY MESSAGES  
- The safety of firefighters and the public is always the highest priority during wildfires. 
- Wildfire behavior is largely contingent upon weather and fuel conditions. 
- Partnerships at local, regional, and national levels help us be more effective fire managers. 
- Homeowners and communities can help firefighters by crating defensible space around homes 

and structures. 
- Unauthorized use of unmanned aircraft, also known as UAS, “drones,” or remote controlled 

model aircraft, in a fire area endangers the lives of pilots and firefighters. 
 

TACTICS 

 Info Center  

 Daily Briefings 

 Daily Updates and/or News Releases 

 Notification Calls to Key Contacts 

 E-mail 

 Host Unit Website 

 Inciweb (https://bit.ly/Inciweb) 

 Interagency Fire Info Website 

 Social Media (https://bit.ly/PIO-SMEM) 

 Business Cards with Fire Info # / links  

 Fire Info Boards 

 Traplines  

 Roving Contacts 

 Community Meetings 

 Community Events 

 Educational Handouts - Firewise, etc. 

 Media Escorts 

 Press Conference 

 Public Service Announcements 

 Tours of Camp / Fire 

 VIP Briefing Packets  

 Camp Boards  

 Info for Spike Camp  

 Employee Meetings 

 Internal 
Texts(https://bit.ly/InternalText) 

 Incident Newsletter 

 Streaming  

 Other 

 
EVALUATION 
- Accurate media coverage?  Web chatter? Community feedback? Host unit feedback? 
- See Sample Activity Report Template on p. 37 
- Templates for Monitoring - https://bit.ly/HowToMonitor & https://bit.ly/HowToAnalytics 
-     google.com/alerts 
-     socialmention.com 

- social-searcher.com 
- Hootsuite.com 

- Site Analytics:   
    Twitter, Facebook, etc. 

http://bit.ly/Inciweb
http://bit.ly/PIO-SMEM
http://bit.ly/InternalText
http://bit.ly/HowToMonitor
http://bit.ly/HowToAnalytics
http://www.google.com/alerts
http://www.socialmention.com/
https://www.social-searcher.com/
https://hootsuite.com/plans/free
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2018 NATIONAL FIRE SEASON THEMES 
https://www.nifc.gov/PIO_bb/messages.html 

 
The safety of firefighters and the public is always the highest priority during wildfires. 

 During wildfires, agency administrators and incident managers make choices to 
minimize risk and focus on areas where firefighters can be the most effective. 

 No structure or resource – cultural or natural – is worth a human life. 

 Law enforcement officers and wildland firefighters work together to provide timely 
evacuation notices so the public can act quickly and safely. It is very important for the 
public to heed these notices, as people often perish in wildfires when they disregard 

evacuation orders or when they decide to evacuate too late. 

 It is critical for homeowners to have escape plans and materials ready in the event of a 

wildfire evacuation. Learn more about Ready, Set, Go! at 
http://www.wildlandfirersg.org/ 

 During periods of high wildfire activity, it is not uncommon for wildfire suppression asset 

requests to exceed supply. During these periods, fire managers work together to 
prioritize incidents – those that threaten lives, property, community infrastructure and 

valuable natural and cultural resources receive assets first. All other incidents receive 
suppression assets as quickly as possible. 

 
Wildfire behavior is largely contingent upon weather and fuel conditions. 

 The 2017 fire season was near normal for the number of reported wildfires (102 
percent of the 10-year annual average), though more than 10 million acres burned, 
which is well above normal (153 percent of the 10-year average). 

 Though an average number of wildfires occurred last year, high temperatures, 
prolonged wind events and lack of precipitation created above normal wildfire behavior 

for firefighters. 

 Fire activity began early in 2017; by the end of March, more than 1.6 million acres 
burned in the southeastern U. S. 

 Intense fire behavior continued throughout the year, as large wildfires consumed above 
normal acreage throughout the western states. 

 The U.S. Forest Service and other wildland fire specialists are beginning to use the 
term “Fire Year” instead of “Fire Season,” because fire activity is occurring year-round. 

 

Partnerships at local, regional, and national levels help us be more effective fire 
managers. 

 Together, we can be more effective than as individual agencies. 

 Projects that reduce vegetation across land management boundaries help protect 
communities and create ecosystems that are more resilient to wildfire. 

 Homeowners and communities can help firefighters by creating defensible space 
around homes and structures. 

 Taking individual responsibility to reduce flammable materials around homes and 
communities before a fire occurs can help keep the public and firefighters safe. 

 We will not risk firefighters’ lives to save indefensible homes. 

 
Unauthorized use of unmanned aircraft, also known as UAS, “drones,” or remote 

controlled model aircraft, in a fire area endangers the lives of pilots and firefighters. 

 Never fly unmanned aircraft over or near fires. 

 Learn more about the No Drone Zone and find outreach tools and resources at 

http://www.nifc.gov/drones/ 
 

 

https://www.nifc.gov/PIO_bb/messages.html
http://www.wildlandfirersg.org/
http://www.nifc.gov/drones/


12 

 

KEY MESSAGES 
Tell the Story: What, Why, How, Who, When, Where 

 
Key Message: 
 
 
Key Message: 
 
 
Key Message: 

 
Generally PIOs on incidents can respond to questions from all news media, including national news 

media, about the incident only. PIOs should refer all questions that are broader in scope to the host unit 
Public Affairs Officer to determine whether they should be addresses locally, regionally or nationally. 

 
See also Interview Tips in the PMS 461 Incident Response Pocket Guide and   

Media Access Guidelines in the PMS 201 Wildland Fire Incident Management Field Guide  

MEDIA INTERVIEW TIPS 
 

ANSWERS TO DIFFICULT 

QUESTIONS 
 

ESCORTED 

FIRELINE VISITS 
 

 

Prepare Three Key 

Messages  
 

 

Ask Reporter Before the 

Interview 

- What questions should I 

expect? Live or Taped? 
 

 

During the Interview 

- Give 10-20 second 

answers 

- Use key messages 

- Say most important thing 

1st  

- When you’re done, be 

quiet. 

- If you botch the answer, 

ask to start again (if taped). 

- Remove sunglasses / hats. 

- Look at the reporter, not the 

camera. 

- NEVER talk “off the 

record.” 

- Don’t speculate, give 

opinion or say “no 

comment.” 

- Don’t speak for other 

agencies. 

- Avoid yes/no answers. 

- Don’t disagree with 

reporter, instead clarify and 

correct the information. 

 

 

Asked about a problem? 

Talk about a solution. 

 
 

Use Your Key Messages 
 

- This is an evolving situation 

and I will update you as soon 

as we have additional 

information. 

- Everyone is working hard to 

reach their objectives safely 

and efficiently 

- All of our efforts are directed 

at bringing the situation 

under control. 

- I’m not the authority on that 

subject.  You should talk to… 

- I am unfamiliar with that 

statement and am not 

prepared to respond to it. 

- I will look into it and get back 

to you. 

- That’s a hypothetical 

question and it’s not 

appropriate for me to 

speculate. 

- Our job is to manage public 

lands according to the law, 

balancing public use and 

resource protection. 

  

Visits to the fireline must 
have the approval of the 
IC/Burn Boss. 
 
Visitors must maintain 
communication with DIVS or 
fireline supervisor. 
 
Visitors must have training in 
the proper use of PPE & 
shelter. 
 
Escorts must be qualified 
single resource boss or       
approved by IC / Burn Boss.  
 
Required PPE: 
- Wildland fire boots 
- Long sleeve aramid shirt 
- Flame resistant trousers 
- Hard hat with chinstrap 
- Leather gloves 
- Fire shelter 
- Cotton undergarments 

 
Requirement for hand tool 
and water to be determined 
by escort. 
 

Interagency Standards for 
Fireline Safety (The 

“Redbook”) Chapter 7, Safety 
for Escorted and Non-
Escorted Fireline Visits 

(https://www.nifc.gov/policies/ 
pol_ref_redbook.html). 

 

https://www.nwcg.gov/sites/default/files/publications/pms461.pdf
https://www.nwcg.gov/sites/default/files/publications/pms210.pdf
https://www.nifc.gov/policies/pol_ref_redbook.html
https://www.nifc.gov/policies/pol_ref_redbook.html


13 

 

 
 

TASKS 
 

- Clone Radio 
- Lunch / Water 
- Shower / Break  

- Call Home 
- Check Work E-mail  
- Check Work Voicemail 

- CTR  
- Unit Log 
- Charge Cell / Camera 

SPECIAL PROJECT ASSIGNED TO DUE 

Communication Strategy   
Demob Plan   
Transition Plan    
Executive Summary   
Thank Yous   
Ensure Documentation is Complete   
 DATE DATE DATE DATE DATE DATE DATE 

Pick up Maps WHO WHO WHO WHO WHO WHO WHO 

Print / Make Copies        

AM Briefing        

Press Conference        

Cooperator PIO Call        

Cooperator Meeting        

Update PAO & WO        

Draft AM/PM Update        

E-mail Daily Update        

Staff Info Center        

Phones         

VIP Packet / Escort        

Staff Evac Center        

Trapline        

Mail        

Camp Boards        

Camp Tour        

Media Escort        

Inciweb / Website(s)        

Respond to E-mail         

Social Media        

Monitor News/Web         

Photos / Videos        

C&G Meeting        

Planning Meeting        

Community Meeting        

PM Briefing        

Map Request        

Doc Box        
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PLOTTER PAPER SIZES 
ANSI C 17 x 22      ANSI E      34 x 44          ARCH B      12 x 18      ARCH D      24 x 36 
ANSI D 22 x 34      ARCH A      9 x 12          ARCH C      18 x 24      ARCH E      36 x 48 
   

 

 
 

COPIES 
 IAP 209 Sit Rep Updates Lg Map Sm Map Photos 

PIOs        
Info Center        
Camp Boards        
Trapline 

Internal 
only 

Internal 
only      

        
TOTAL        

TRAPLINE 
Local Businesses, Ranger Stations, Road Block Staff, ICP Security, ICP Boards,  Helibase, etc. 

Location  Notes (pins, tape, etc.) What’s Posted 

   

   
   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

EQUIPMENT 
 Equipment Assigned To Out In Return To 

     

     



15 

 

PIO RESOURCES - If span of control exceeds 3-7, make changes. 

Avail 
Extend 

               

Day 14                

Day 1                

H
o
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e
 

U
n

it
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d
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in
g

                

O
-#

                

V
e
h
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Task 
book 

               

Qual                

C
e
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N
a
m

e
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KEY CONTACTS 

KEY CONTACTS NAME CONTACT INFO 

HOME UNIT TIMEKEEPER  
 

  

HOME UNIT DISPATCH 
 

  

FIRE INFO  
 

  

IC 
 

  

LIOF 
 

  

AGENCY ADMINISTRATOR 
 

  

PAO 
 

  

Concur Travel (USFS)  
(877) 372-7248. 
opt 3 https://cge.concursolutions.com/ 

Concur Travel (DOI) 
(855) 847-6398, 
opt 5 https://cge.concursolutions.com/ 

Wildland Firefighter 
Foundation 

(877) 336-2950   
(208) 336-2996 

wffoundation.org  

info@wffoundation.org  

Disaster Distress Helpline (800) 985-5990  https://disasterdistress.samhsa.gov/ 

Inciweb Helpdesk (866) 224-7677 
https://iia-hd.peckham-enclave.us/ 
https://www.nifc.gov/PIO_bb/inciweb.html 

Christine Cozakos 
Inciweb Business Lead 

(208) 387-5145 ccozakos@fs.fed.us 

NIFC Fire Info 
 

(208) 387-5050 
https://www.nifc.gov 

https://www.nifc.gov/PIO_bb/staff.html 

Randy Eardley  
NIFC BLM Ext Affairs 

(208) 387-5895 reardley@blm.gov 

Robyn Broyles 
NIFC BIA Ext Affairs 

(208) 387-5473 Robyn.Broyles@bia.gov 

Tina Boehle 
NIFC NPS Ext Affairs 

(208) 387-5875 Tina_Boehle@nps.gov 

Robert Eaton 
NIFC FWS Ext Affairs 

(208) 387-5583 robert_eaton@fws.gov 

*^Jennifer Jones 
NIFC USFS Ext Affairs 

(208) 387-5437 
(208) 631-0406 cell jejones@fs.fed.us 

*Isaiah Hirschfield  

National Fire Desk Manager 
(202) 205-1450 

firedesk@fs.fed.us 

isaiahhirschfield@fs.fed.us 

*USFS WO Acting Public 
Affairs Specialist 

(202) 572-1644  

^Erin O’Connor 
FS WO Director of 
Communications 

(202) 205-1470 eoconnor@fs.fed.us 

^Kathryn “Katie” O’Conner 

FS WO Deputy Director of 
Communications 

(202) 205-3643 kathrynoconnor@fs.fed.us 

*Notify about  all federal and non-federal fires of interest to the news media, elected 
officials, and senior USFS and USDA leadership   

^Work with the local or regional USFS PAO to notify about all VIP visits on USFS incidents  

http://www.wffoundation.org/
mailto:info(a)wffoundation.org
https://disasterdistress.samhsa.gov/
https://iia-hd.peckham-enclave.us/
https://www.nifc.gov/
https://www.nifc.gov/PIO_bb/staff.html
mailto:Tina_Boehle@nps.gov
mailto:firedesk@fs.fed.us
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KEY CONTACTS                                    
KEY CONTACTS NAME CONTACT INFO 

EXPANDED DISPATCH 
 

  

AGENCY WEBMASTER 
 

  

AREA COMMAND 
 

  

JIC 
 

  

EOC 
 

  

SHERIFF 
 

  

RED CROSS 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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SUMMARY OF ACTIONS (ICS 214) 
Date / Time Major Events 

Important decisions, significant events, briefings, reports on conditions, etc. 
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MAP / PHOTO / VIDEO TIPS

SAVING INCIDENT MAPS FROM FTP 
https://ftp.nifc.gov/public/incident_specific_data/  

> double click on appropriate GACC  
> double click on appropriate folder for 
current year incidents (skip this step if 
fire names are listed in this folder) 
> double click on incident name  
> double click on “GIS” 
> double click on “Products” 
> double click on folder with current date  

- Right click on the file you want to save 
- Select “Save Link As” and save it to your 

desktop or somewhere you can find it 
 
SAVE a PDF as a JPG 
- Double click on the pdf file 
- “Edit” > “Copy File to Clipboard” 
- “File” > “Exit” 
- Click on the “Start” Menu, “All Programs” 

> “Accessories” > “Paint” 
- “Edit” > “Paste” 
- Then click “Crop” in the toolbar 
- “File” > “Save As” 
- Rename the file to something relevant 

like CubComplexBriefingMap_07-07-08 
- Click on the down arrow to change “save 

as type” to “jpg” 
- Click on the down arrow to change the 

“save in” location to the desktop or 
appropriate folder 

- “Save” 
 
RESIZE PHOTOS 
With Microsoft Office Picture Manager 
- Right click on image 
- “Open With” > “Microsoft Office Picture 

Manager” 
- “Picture” > “Compress Pictures” 
- “Web pages” 
- “OK” 
- “File” > “Save As” 
- Rename the file 
- “Save” 
Or Resize Photos With Paint 
- Right click on image 
- “Open With” > “Paint” 
- Click on “Select” then “Select All” 
- Click on “Resize” 
- Resize by Percentage or Pixels 
- Click on “Crop” 
- “File” > “Save As” 
- Rename the file & select “JPG” 
- “Save”  
 

BATCH RESIZE ALL PHOTOS  
IN A FOLDER 
- Select the folder you want to resize 
- Right click, “Copy” 
- Then right click and “Paste” on desktop 
- Right click on the folder you just created 
- Right click and “Rename” as Photos for 

Web or something similar 
- Double click on the folder 
- “Edit” > “Select All” 
- “Open With” > “Microsoft Office 

 Picture Manager” 
- “View” > “Thumbnails” 
- “Edit” > “Select All” 
- “Picture” > “Compress Pictures” 
- “Web pages” 
- “OK”, then “File” > “Save All” 
 
BATCH RENAME ALL PHOTOS 
 IN A FOLDER 
- Double click on the photo folder 
-  “Edit” > “Select All” 
- “Open With” > “Microsoft Office  

Picture Manager” 
- “View” > “Thumbnails” 
- “Edit” > “Select All” 
- “Edit” > “Rename” 
- Change the file name then select “OK” 

 
Or Batch Rename in Windows Explorer 
- Select multiple files in a folder. To do so, 

press and hold down the CTRL key while 
you are clicking files. 

- After you select the files, press F2. 
- Type the new name, then press ENTER. 
- Files will be renamed & numbered 

chronologically. 
 

PAUSE BEFORE POSTING 
Consider agency guidelines and potential 
ramifications before posting pictures of: 
- fireline personnel not wearing full PPE 
- identifiable structures (ie. addresses) 
- burning / burned structures 
- inmate crews 
- faces of children 
- accident or investigation scenes 
- sensitive natural or cultural resources 
- whiteboards / flipcharts with passwords 

or internal contacts listed 
- license plates 
 

https://ftp.nifc.gov/public/incident_specific_data/
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SOCIAL MEDIA (https://bit.ly/PIO-SMEM & https://bit.ly/SocialMediaStrategySample) 

 
ORDERING  

 Suggested resource order language for 
ordering a multimedia PIO – 
https://bit.ly/OrderSMEMPIO 

 NWCG Procedures for Off-Site/Remote 
Incident Assignments – 
https://bit.ly/RemoteIncidentAssignment 

 
INITIAL SETUP 

 Create incident e-mail account 
(https://bit.ly/PIOEmail) 

 Create mass e-delivery account if 
needed, and with host unit approval 

 Request Inciweb access from host unit 
(https://bit.ly/Inciweb) 

 Determine protocol for posting to a 
backup website (host unit, partner 
agency, team site, etc.) 

 Request social media access from host 
unit (Flickr, Twitter, etc.)  

 Work with partners or VOST (to create 
incident social media accounts if needed 
(Accessibility tips https://bit.ly/tips508) 

 Create incident QR code 
(https://bit.ly/HowToQRCode) 

 Set Up Google Drive  Folders 
(https://bit.ly/PIOGoogleDrive) 

 Set up (Google.com/alerts) 

 Set up Google Voice 
(https://www.google.com/voice) 

 
AM 

 Post Ops video briefing, media briefing, 
etc. to social media and Inciweb 

        https://bit.ly/AccessibleVideoSocialMedia 

 Post News Release to Inciweb, Backup 
Website and Social Media 

 E-mail News Release 

 Check FTP for maps and post to 
Inciweb, Backup Website and Social 
Media (p. 34) 

 
PM 

 Stream and/or post community meeting 
video to social media & Inciweb 

 Post News Release to Inciweb, Backup 
Website and Social Media 

 E-mail News Release 

 Check FTP for maps and post if new 
maps available (p.34) 

ONGOING 

 Monitor and reply to e-mail 

 Update and maintain e-mail list 

 Send Internal Texts for PIOs 
(https://bit.ly/InternalText) as approved 
by lead PIO (and IC, OPS and LIOF)  

 Update list of PIO cell numbers 

 Monitor and reply to online comments 
(https://bit.ly/CommentGuidelines) 

 Identify and document media,  partner 
agency, and other key sites and monitor 
accordingly (https://bit.ly/HowToMonitor) 

 Identify rumors and respond accordingly 

 PDF and/or print interesting, significant, 
or controversial articles for 
documentation 

 PDF and/or print Incident Websites and 
Social media daily for documentation 

 Update and maintain Google Docs 

 Update and maintain documentation on 
multimedia protocols 

 Check FTP for maps and post if new 
maps available 

 Post announcements (community 
meetings, partner agency news 
releases, restrictions, etc.) to Inciweb, 
Backup Website and Social Media 

 Manage, Label and Upload photos and 
videos as available 

 Stream Community Meetings (Ex.  
https://live.fb.com/about/) 

 
CLOSEOUT 

 Prepare social media analytics 
(https://bit.ly/HowToAnalytics) 

 Tally stats (p.37) for Executive Summary  

 Prepares transition info (passwords, 
protocols, etc.) 

 Give host unit and/or next IMT access to 
incident g-mail and social media  

 Ensure Google Drive file is complete 

 Ensure hard copies of websites are 
submitted to documentation  

 Provide an electronic copy of PIO 
documentation to host unit PAO 

 Post final closeout message with where 
to go or who to contact  for fire info 

 Set up g-mail automated response with 
who to contact for fire info 

http://bit.ly/PIO-SMEM
http://bit.ly/SocialMediaStrategySample
http://bit.ly/OrderSMEMPIO
http://bit.ly/RemoteIncidentAssignment
http://bit.ly/PIOEmail
http://bit.ly/Inciweb
http://bit.ly/tips508
http://bit.ly/HowToQRCode
http://bit.ly/PIOGoogleDrive
http://www.google.com/alerts
https://www.google.com/voice
http://bit.ly/AccessibleVideoSocialMedia
http://bit.ly/InternalText
http://bit.ly/CommentGuidelines
http://bit.ly/HowToMonitor
https://live.fb.com/about/
http://bit.ly/HowToAnalytics
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INCIWEB BEST PRACTICES 
□ Once logged in, go to the admin tab to 

lookup the Superuser for any unit 

□ Name the fire “Wallow Fire” instead of 

“Wallow” so the auto-generated hashtag 

for the @Inciweb twitter post will be 

#WallowFire instead of #Wallow 

□ Click the * next to the coordinates box 

for a link to a lat/long converter  

□ Post news releases as articles so they 

generate a tweet on @Inciweb  

□ Use a descriptive article headline with 

the key message vs. May 3 update since 

the headline becomes a @Inciweb tweet 

and that automatically includes incident 

name and a link to the article  

□ If your formatting is goofy, highlight all 

the text in the article and delete, then 

backspace to the very beginning of the 

text entry field to clear existing 

formatting 

□ When copying (ie. from a news release), 

copy and paste text into a new Word 

Doc to clear formatting issues. Highlight 

the text you want to copy (don’t include 

headers / logos) and right click-copy to 

copy, then right click-paste to paste into a 

new Word doc. Click the down arrow on 

the clipboard icon and select the clipboard 

with an “A” to keep text only. Reformat your 

document accordingly.  

□ Post nuggets of info (community 

meetings. etc.) as announcements so 

they generate a tweet on @Inciweb  

□ When uploading photos, name them 

with the date they were taken (otherwise 

folks assume they are from the date they 

were posted; which can be misleading if 

you’re posting active fire behavior photos 

as crews are demobing on Day 14) 

□ Use descriptive photo captions to 

incorporate your key messages 

□ Post maps as .jpg (see p. 35) so you can 

preview them as thumbnail images; then 

add the PDF as a related file (once you 

post the image, scroll to the far right of the 

photo table to add a related file) 

□ Test the QR codes on maps before 

posting to make sure they don’t go to 

sensitive maps of cultural resources, etc. 

□ Always double check the public side 

once you make changes on the admin side 

VIP VISIT  
 USFS: Notify  WO, Fire Desk & NIFC  

 Who to invite? Work with AA, IC & PAO. 

 Invite them to visit & provide incident info 

 Notify the IC and security manager 

 Confirm departure and return times 

 Confirm specific areas the tour will cover 

 Arrange for appropriate vehicles(s). 

 Arrange aircraft with air ops branch director 
(Note: federal law restricts use of public 
aircraft for this purpose.) 

 Assign a tour guide who knows the area 
and can answer questions 

 Provide all appropriate safety gear  

 Arrange for lunch / water 

 Provide tour guide with a list of the 
dignitaries’ proper names and titles. 

 Security provided? By Whom?  

 Expect a group of assistants to arrive with 
each dignitary.  

 Prepare briefing packet(s) 

 

PRESS CONFERENCE  
 Get the IC’s approval. 

 Contact dignitary’s press person and 
involve in the planning. 

 Establish a facilitator with maps. 

 Select the site, considering: 

 Close to the action without interfering in 
the operation. 

 Room for cameras, light stands, 
microphones, satellite truck parking, 

 Speakers should be on a riser where 
they can be seen and photographed. 

 Consider what is behind the speaker, 
(ex, a window would glare on TV). 

 Access to power for PA equipment. 

 Notify the media of the time, place, and 
purpose of the briefing and who will be 
speaking.  Include a contact name and 
phone number. 

 Prepare handouts and maps with current 
info on the incident and an agenda with the 
names and titles of the speakers.  
Distribute to the media as they arrive. 

 A facilitator should announce the purpose 
of the news conference explain any ground 
rules, and introduce each speaker.  That 
person should keep the briefing moving 
and coordinate questions and answers 
after the speakers are finished. 

 Remember every mic is a live mic. 



37 

 

COMMUNITY MEETING  
Making Arrangements 

□ Contact names & phones? Facility 
administrator and onsite setup contact. 

□ Submit name and contact info and details on 
what we’ll be using and how often on General 
Message to ORDM for land use agreement 

□ What time can we get in to setup? (ideally 2 
hours ahead of time) and/or test in advance? 

□ Formal name of facility? Street Address for 
GPS? Or instructions on how to get there?  

□ Travel Time from ICP? 

□ PA system? Acoustics? Lighting? (test in 
advance if possible) 

□ Projector(s)? Screen(s)? may need an extra  
of each if CART captioning is available 

□ Where to post hard copy maps? may need to 
order plywood fire info board if needed 

□ WiFi? Able to access Facebook to 
Livestream? (often blocked on school 
systems) Power source? 

□ Adequate seating? Parking? 

□ Inside/outside? 

□ Backdrop? Facing sun? Background noise? 

□ Overflow contingency? 

□ Map request 

□ Assign a facilitator (usually a PIO)  

□ Assign PIO(s) to monitor Facebook comments 

□ Coordinate speakers for agenda and forward 
them location info & let them know to meet 15 
min before meeting starts to finalize agenda 
and discuss who will address anticipated 
audience questions 

o Ops 

o IC 

o County Sheriff’s Office 

o County Emergency Management 

o Air Quality 

o Host Unit(s) 

o Other 

Notifications 

 C&G – especially IC, OPS, LIOF 

 AA, AREP, PAO from host agencies 

 Partner land management agencies 

 Law enforcement 

 Elected officials – local, state, US  

 Permittees 

 Joint Information Center (JIC) 

 MAC Group  

 Area Command 

 Red Cross 

 Inciweb / social media / trapline / daily update 

 

 

 

Visuals 

 Map Request – E size or BAM to post on 
stage, an electronic version to projects, and 
one or two E size to post on side of room 

 Ensure map shows distance to the community 
where meeting is being hosted 

 Consider fire history, progression, IR maps 

 Powerpoint / photos / videos / posters 

 Large fire info website and phone #s to post 

Supplies 

 Maps and electronic files for presentation  

 Wide blue tape or gaffers tape 

 Tripod(s) with adapter to hold phone/ipad 

 Fully charged phone/iPad/video camera with 
enough memory and space to record 

 Green laser pointer (more visible online) with 
extra batteries 

 Projector (if needed) 

 Laptop (if needed) 

 Portable PA system (if needed) 

 Staple gun and staples 

 Tape (scotch and masking) 

 Pushpins 

 Staple remover tool 

 Flip charts / markers 

 Extension cord / Surge strip 

 Fire info signs to post outside 

 Water for speakers on stage 

 Case of water & cooler  

Handouts 

 Copies of agendas for speakers 

 Fire maps & updates 

 Fire info business cards or flyers 

 Firewise materials 

 Smoke & air quality information  

 Evacuation, Ready Set Go, and Emergency 
Alert information (Sherriff)  

 Red Cross information  

 If You Fly, We Can’t 

Facilitation 

□ Thank host facility / contacts 

□ Emergency exits, restrooms, etc. 

□ Acknowledge online viewers and let them 
know you’re monitoring questions 

□ Summarize agenda 

□ Highlight Inciweb, Fire Info #s, etc. 

□ Hold questions until end 

Analytics & Monitoring 

 Count # attendees in person 

 Count peak # watching Livestream live 

 Monitor Facebook questions  

Follow-Up 

□ Record stats on unit log  
□ Send thank yous as applicable 
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 ACTIVITY REPORT 
Date:               Total 

MEDIA                 

Hours staffed                

# interviews, in person                

# interviews, phone                

Translator available (Y/N)                

# escort tours, camp                

# escort tours, line                

Description: Light, moderate, heavy coverage? Local, regional, national, international interest? 

                

COMMUNITY                

# Trapline miles                

# Trapline stops                

# Info boards updated                

In which communities: 

# staffed info locations:                

In which locations: 

# people talked to                

# community meetings                

# people in attendance                

In which locations: 

Translator available (Y/N)                

                

INFO CENTER                

Hours staffed                

# phone calls taken                

# walk-in visitors                 

# written updates                 

Translation available (Y/N)                

# other docs prepared                

Description: 

# camp tours given                

# people on camp tours                

# bulletin boards posted                

# VIPs briefed/escorted                

                

ELECTRONIC MEDIA                

# web pages updated                

Description: 

# social media views                

# social media shares                

# social media reach                

                

                

 
EXECUTIVE SUMMARY 

 
SIGNIFICANT EVENTS 
 
 
CHALLENGES & RESOLUTIONS 
 
 
LESSONS LEARNED 
 
 
MANAGEMENT EFFICIENCIES  
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TRANSITION / CLOSE-OUT 
 
TRANSITION PLAN 
 Transition Form 

https://bit.ly/PIOTransition 

- Remaining staff & planned demob 

- Staffing recommendations 

- Info center / trapline locations 

- Schedule of conference calls, etc. 

- Talking points / key messages 

- Recommended tasks 

- Political considerations 

- Contacts  

- Passwords 

 
TRANSITION CLOSE-OUT 
 Requests for Recognition 
 Request Demobs In Advance (specify 

name, O#, date and time of release, 
method of transportation, jetport, and if 
reservation have already been made or if 
you’re requesting they be made) 

 Sign Taskbooks (Evaluation Forms - 
https://bit.ly/TaskbookEvalForm 

 Performance Evaluation (ICS-226) 
https://bit.ly/ICS226 using PIO 
Performance Criteria: 
- Knowledge of the job 
- Ability to work with others 
- Organizational skills 
- Attitude 
- Safety 
- Leadership 
- Flexibility 
- Obtain necessary supplies 
- Media interaction 
- Community interaction 
- Initiative 

 Burn DVD for Doc Box 
 Doc Box to Plans  

 Community Relations / PSAs 
 Closure Orders / Restrictions 
 Info Summary / Comm Strategy 
 Media Log / Key Contacts / 

Traplines 
 Newspaper Clippings 
 Press Releases / Daily Fire 

Updates 
 Public Meetings / Briefings 
 Special Events / Tours / VIP 

Visits 
 Thank You Letters 
 Web Pages / Videos / Photos 
 Unit Logs 

 General Messages 
 
FINAL CLOSE-OUT 
 Tear Down Trapline / Boards 
 Final update on Inciweb website 
 Cancel Newspapers 
 Cancel Phones/Internet 
 Return Equipment 
 
DEMOB 
 Check on Travel Arrangements 
 Ground Support  
 Supply 
 Time 
 Training Specialist 
 
UPON RETURN HOME 
 Call Dispatch 
 Update ROSS status 
 Keep a copy of your resource order, fire 

timesheet, and performance evaluation 
for your records. 

 Make a copy of your taskbook and keep 
in it a safe place in case you ever lose 
the original. 

 Submit your fire timesheet to your home 
unit timekeeper. 

 Submit a travel voucher to your home 
unit travel coordinator; attach a copy of 
your resource order.   

 
POST-SEASON 
 Submit an updated  IQCS Individual 

Firefighter Update Form 
(http://iqcs.nwcg.gov/articles/forms/28-
iqcs-responder-update-sheet) with 
copies of training certificates, resource 
orders, performance evals, and 
completed taskbooks to your home unit 
at the end of the season. 

 
 

AFTER ACTION REVIEW 
Focus on the what, not who. 

 

- What did we set out to do? 

- What actually happened? 

- Why did it happen?  

- What are we going to do next time?  

- Sustain/Maintain Strengths 

- Improve Weaknesses 

 

http://bit.ly/PIOTransition
http://bit.ly/TaskbookEvalForm
http://bit.ly/ICS226
http://iqcs.nwcg.gov/articles/forms/28-iqcs-responder-update-sheet
http://iqcs.nwcg.gov/articles/forms/28-iqcs-responder-update-sheet
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PIO RESOURCES 
 

NIFC PIO Bulletin Board https://www.nifc.gov/PIO_bb/pio_main.html 

Critical Incident Resources https://www.nifc.gov/PIO_bb/critical_incidents/index.html & 

https://www.nifc.gov/PIO_bb/docsCritical.html 

Situation Report https://www.nifc.gov/nicc/sitreprt.pdf (How to Read https://bit.ly/HowToReadIMSR) 

National Fire Maps https://www.nifc.gov/fireInfo/fireInfo_maps.html  

Geographic Area Coordination Centers (GACC) Portal http://gacc.nifc.gov/ 

National Fire Weather http://weather.gov/fire 

NWCG Glossary of Wildland Fire Terminology http://www.nwcg.gov/glossary 

ICS Forms http://www.nwcg.gov/publications/ics-forms 

Taskbooks http://www.nwcg.gov/publications/position-taskbooks 

NWCG Public Information Officer Position Overview https://www.nwcg.gov/positions/cgs 

National Incident Management System Basic Guidance for PIOs https://bit.ly/NIMS-PIO-Guide 

Joint Information Center (JIC) Model including job aids https://bit.ly/JICModel 

Military Use Handbook Chapter 10 Public Info - http://www.nifc.gov/nicc/logistics/references.htm                                                                                                                       

USFS Fire and Aviation Qualifications http://www.fs.fed.us/fire/publications/index.html#fsfaqgForest 

Unit Identifiers https://wfmi.nifc.gov/unit_id/Publish.html 

Frequently Asked Questions http://www.nifc.gov/aboutNIFC/about_faq.html 

Firewise http://www.firewise.org and Fire Adapted Communities http://www.fireadapted.org/ 

Ready, Set, Go! http://www.wildlandfirersg.org/ 

What to Do Before, During, and After a Wildfire http://www.ready.gov/wildfires 

Health Effects of Smoke https://airnow.gov/index.cfm?action=topics.smoke_wildfires 

Aircraft Recognition Guide https://bit.ly/FireAircraftRecognitionGuide 

Burned Area Emergency Response http://www.nifc.gov/BAER/Page/NIFC_BAER.html 

Sample Resources for Evacuees Returning Home http://nmfireinfo.com/information/after-a-wildfire/ 

 
FIRE DATA IN GOOGLE EARTH 

 

BASIC - Most large fires on Inciweb have an interactive Google Earth map on the main incident 

page (This map is generated based on the coordinates you enter into the 209 data entry screen in 

Inciweb).  Anyone can view the map, scroll around to view different areas, zoom in and out, and 

select a hybrid or terrain view without having to install Google Earth on their computer.   
 

ADVANCED - You must have the Google Earth program installed and open on your computer 

before opening the layers below.  You can download the free program at www.google.com/earth.  

- For a more detailed view with almost real-time info showing approximate heat visit 

http://activefiremaps.fs.fed.us/googleearth.php. Click on the “Current” AFM KML Bundle.   

- Many fire perimeters are also available through GEOMac (http://www.geomac.gov) Click on 

"View Perimeters" then "View KML" and choose the perimeter to view or download the dynamic 

KMZ (http://www.geomac.gov/asp-bin/GeomacKML/GeoMAC.kmz).  

- Additional Related Wildland Fire KML/KMZ Links - http://geta.firenet.gov/web-links 

 

 

 

https://www.nifc.gov/PIO_bb/pio_main.html
https://www.nifc.gov/PIO_bb/critical_incidents/index.html
https://www.nifc.gov/PIO_bb/docsCritical.html
https://www.nifc.gov/nicc/sitreprt.pdf
http://bit.ly/HowToReadIMSR
https://www.nifc.gov/fireInfo/fireInfo_maps.html
http://gacc.nifc.gov/
http://weather.gov/fire
http://www.nwcg.gov/glossary
http://www.nwcg.gov/publications/ics-forms
http://www.nwcg.gov/publications/position-taskbooks
https://www.nwcg.gov/positions/cgs
http://bit.ly/NIMS-PIO-Guide
http://bit.ly/JICModel
http://www.nifc.gov/nicc/logistics/references.htm
http://www.fs.fed.us/fire/publications/index.html#fsfaqgForest
https://wfmi.nifc.gov/unit_id/Publish.html
http://www.nifc.gov/aboutNIFC/about_faq.html
http://www.firewise.org/
http://www.fireadapted.org/
http://www.wildlandfirersg.org/
http://www.ready.gov/wildfires
https://airnow.gov/index.cfm?action=topics.smoke_wildfires
http://bit.ly/FireAircraftRecognitionGuide
http://www.nifc.gov/BAER/Page/NIFC_BAER.html
http://www.google.com/earth
http://activefiremaps.fs.fed.us/googleearth.php
http://www.geomac.gov/
http://www.geomac.gov/asp-bin/GeomacKML/GeoMAC.kmz
http://geta.firenet.gov/web-links
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INCIDENT WITHIN AN INCIDENT (IWI) PIO EMERGENCY ACTION PLAN 
 
□ The closest operationally qualified resource will initially oversee the emergency and activation 

of the IEP as the Incident Within an Incident (IWI) Incident Commander.   
□ Radio communication associated with the IWI will take priority over other radio traffic. 
□ No accident related information will be released to the public without the approval of the 

Incident Commander (Agency Dispatch will notify Agency Emergency Coordinator, Line 
Officer and Regional Office).  For fatalities, Agency Dispatch will contact Sheriff’s Office and the 
victim’s employer. 

□ Victim(s) name, tail number, crew, engine number, etc. will NOT be transmitted over the 
radio. Deceased individuals and their equipment are not to be moved, except to accomplish 
rescue work or to protect the health and safety of others.    

□ At the time of a reported incident, the Command and General Staff (C&G) will begin 
implementation of the IEP.  Initially the C&G will assemble at a pre-identified meeting location 
near the Communications Unit to communicate, share information, coordinate and begin 
developing a common operating picture to support the IWI and to provide for continuity of 
ongoing operations as required. 

Responsibility Action Green 
Minor,  
non-life 
threatening. 

Yellow 
Potentially 
life 
threatening 
needs 
transport. 

Red 
Life 
threatening 

Public 
Information 
Officer 
 
Primary: 
Information 
Officer/Contact 
info 
 
 
 
 
Secondary: 
As designated/ 
Contact info 

Designates an IWI PIO.  Yes    Yes    

Collects pertinent IWI information.   Yes    Yes    

Coordinates information release 
with Incident Commander and 
Agency Public Affairs Officer.  

 Yes    Yes    

Coordinates with Operations to 
assign Information Officers to filed 
media inquiries at accident scene, 
medevac area, and liaise with 
hospital spokesperson.  

 Yes    Yes    

Coordinates with LOFR and 
Logistics regarding roadblocks, 
evacuations and emergency 
medical information needs. 

 Yes    Yes    

Withholds release of personal 
information until approved by 
Incident Commander and/or 
Agency Administrator. 

 Yes    Yes    

After approval from IC, coordinates 
with plans to arrange a briefing at 
Incident Command Post (ICP) for 
incident personnel. 

 Yes    Yes    

Coordinates with Medical Incident # 
___ as requested. 

 Yes    Yes    

Provide periodic update to section.  Yes    Yes    

Ensure continuity of operation 
within section. 

 Yes    Yes    

Orders Additional Staff as needed.  Yes    Yes    
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SERIOUS INCIDENT COMMUNICATION CONSIDERATIONS 
 

In the event of a serious accident or an 
incident within the incident, there are 
certain reponsibilities that the lead PIO will 
assume.  According to the Organization 
document for Serious Accidents, PIOs 
should follow these steps: 

 During the Agency Administrator 
Briefing, set up the protocol to be used in 
releasing information with the local 
agency: 
A)  The usual manner would be to have 
the local unit authorize the release of 
information. 
B)  Set up who will be the accident 
contact with the local unit.  This person 
might be the public Affairs Officer or 
Administrative Officer.  Set up how the 
release of accident information will be 
handled with the incident Commnander. 
C)  Once an accident ocurs reonfirm 
what protocol wil be followed with the 
local agency. 

 Make sure that no names are released to 
media until the official release is done by 
the local unit. 

 Restrict media from the accident scene 
until the Accident Operations Section 
Chief authorizes entry. 

 Work with the Security Manager to 
prevent accident survivors from being 
interviewed until authorized. 

 Work with the Safety Officer to gather 
correct information in preparing any 
news releases. 

 Set up a press conference and/or 
interviews with the IC or another 
assigned person (i.e. local unit 
representative) after the official release 
of information. 

 
The official release of information regarding 
serious accidents or fatalities will nearly 
always be a responibility of the local unit . 
 
After a fatality: Restrict media access until 
bodies have been removed and all families 
notified.  Then provide media a tour date 
and time and escort them to the scene. 
 
 
 
 
 
 

 
 
Lead PIO (should NOT be unit PAO) 

 Contact AA or IC for initial briefing 

 Contact Agency PAO  

 Delegate the Command Staff Information 
Officer duties to another qualified 
Information Officer for the Fire Incident. 

 Designate Internal, Media & Community  
PIOs 

 Place order for additional PIO staff.   

 Set up notification process to ensure all 
PIOs / PAOs are notified when talking 
points are updated.  

 Ensure PIOs take frequent short breaks  

 Develop talking points for approval 

 Obtain authorization for all info release  

 Interface with / distribute approved 
talking points to: 
 IC / C&G / Liaison Officer 
 Agency Administrator 
 Agency PAO - request they contact: 
 Regional / national public affairs  
 Agency frontliners – dispatchers, 

receptionists, etc.  
 Agency FOIA Coordinator  

 Incident PIOs 
 Elected Officials 
 Partner agency PAOs / PIOs 
 Sherriff’s Department 
 EOC 
 JIC 
 MAC / Area Command 
 FAA / NTSB 
 FAST / SAIT 
 CISM  

 Brief PIOs with incoming teams 

 Prepare transition plan which 
incorporates follow-up including: 
 Continuing impacts, staff rides, 

visitors, traffic, media, production 
companies, etc.  

 Need for follow-up committee  
 Requests for dedication memorials 

(plaques and statues)  
 Plan for facilitating return visits to the 

incident site by family 
members/survivors/visitors  

 Evaluate public information activities / 
adjust communication plan as 
appropriate  

 Provide updates to family members 
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Internal Lead 
- Chase down rumors 
- Interface with operations for updates 
- Update camp boards / spike camp 
- Post paper next to chow line for 

firefighters to write notes to family 
- Prepare for incoming teams / VIPs 
- Prepare briefing packets  
- Designate liaisons/escorts 
- Arrange for transportation 
- Help coordinate press conferences 
- Keep key personnel informed 
- Provide regular updates and contact with 

all internal / family PIOs  
 
Normal Fire PIOs  
-   Continue to provide fire info operations  
 
PIO to work with Family Liaison: 
- Update family before info released to 

media 
- Ask family if they want to talk to the 

media 
- Contact home unit PIOs to help  

coordinate media contacts with      
families back at home 

- Protect the rights of those who do not 
want media contact 

- Prepare condolence letters within  
24 hours (coordinate at all levels in the 
agency) 

- Arrange escorts for families, etc. 
 
Community Lead  
- Post approved talking points in 

information center  (to be updated with 
approved messages only) 

- oversee information center operations  
- provide regular updates and contact with 

all office / community PIOs  
 
Community PIOs   
- Update / staff community info boards 

 
Office PIOs   
- Staff info center phones 
- Update website with approved info 
- Periodically check e-mail and monitor 

blogs  
- Prepare thank-yous and commendations  
- Tasks for volunteers: herding, faxing, etc. 
- Maintain documentation file 
 
 
 
 

Field PIOs 
- Intercept looky-loos and reporters on 

scene, in camp, at hospital, helibase, etc. 
- Provide media/ VIP escorts  
- Coordinate media access to accident 

site, overflights, memorial services, etc. 
 
Media Lead  
- Identify / serve as primary  spokesperson 
- Provide regular updates and contact with 

all field / media PIOs  
 
Media PIOs  
- Contact reporters via phone / return calls 

as soon as releasable info available / 
updated 

- Prepare news release(s) for approval  
- Distribute approved news release 
- Prepare photos/bios of victims 
- Arrange press conferences  
- Designate “media-free” space for 

incident personnel.   
- Designate media briefing area. 
- Consider media needs – phones, work 

areas, parking, deadlines, PPE, photo 
opportunities, interviews, etc. 

- Need for pool photographer? 
- Publicize info phone / website 
- Incorporate key messages 
- Monitor media coverage 
 
MEMORIAL SERVICE CONSIDERATIONS 
 Set up a hotline with a recorded 

message and/or a website where info will 
be shared as soon as it is available. 

 Embed PIOs in planning effort. 

 Set up an e-mail or phone number for 
RSVPs to help anticipate attendance. 

 Work with family to obtain photos, bios, 
establish memorial website, address and 
e-mail to send condolences, preferred 
charity, memorial and funeral service 
info, etc. 

 Clarify and share information on agency 
protocol regarding travel, admin leave, 
uniforms, use of gov’t vehicles, flag-
lowering, and wearing of black bands. 

 Arrange for photos / video of service. 

 Ensure PIOs are familiar with program: 
names and relations of speakers, where 
the honor guard is from, immediate 
family members’ names, what types of 
aircraft are flying in tribute, etc. 

 Thank yous for incident personnel, 
flowers, gifts, donations, etc. 
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INCIDENT-WITHIN-AN-INCIDENT QUESTIONS TO ASK 
 

 

Discuss with Incident Commander / AA 
- Who will handle info release – Incident or Home Unit? 
- Who will approve info release– IC or AA? 
- What other agencies will be releasing information (Sheriff, Contractors, etc.)? 
- Who will speak for the incident if there is an immediate press conference? 
- What information is confirmed? 
- What information is NOT releasable?  
- If names are being withheld, who will know once family has been notified and tell IC?   
- When the IC decides to release the names, how will information find out? 
- How will families / home units / other people most directly affected be provided with critical 

information?   
- How will incident personnel be notified? 
- How will agency personnel be notified (Safety Manager, Personnel Officer, PAO,  

LE Staff, Aviation Mgmt, Solicitor, Tort Claims Officer, etc) 
- How will national personnel be notified (agency director, agency administrators, OIG, etc.)? 
- Who will contact WFF Foundation?  
- How will cooperator personnel be notified? 
- How will fire home unit personnel be notified? 
- What is response for people who want to help?   
- What about specialized help like animal trailers during an evacuation? 

 
 

Discuss with Agency PAO 
- Does host agency have qualified PIOs locally? 
- Can any nearby incidents loan staff?   
- Bring PAO on site with PIOs?  
- Need to establish JIC? 
- Need to establish 800 number? 
- Can incident assist cooperators in need of phones, press conference location, etc.?  

 
Discuss with C&G Staff  
- Will incident personnel be authorized to make one short call home using the incident’s cell or 

stationary phones? 
- Are technical experts (safety, aviation, fire behavior, etc.) available and prepared for media 

interviews? 
 

Discuss with Operations 
- Media access, including overflights? 
- Potential for press to block access / how to manage? 
- How and when will PIO receive updates? 
- Designate an operations liaison to be available to resolve questions of fact. 

 
Discuss with Plans 
- Do any personnel assigned to incident have PIO quals? 
- Need for maps / graphics? 

 
Discuss with Logistics 
- Additional logistics needs for info function – radios, etc?  
- Need to establish media briefing area? 
- Need to establish media-free areas for incident personnel & family? 
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INCIDENT-WITHIN-AN-INCIDENT - FIRST MESSAGE 
Crisis & Emergency Risk Communication - http://emergency.cdc.gov/cerc/ 

 
1. Expression of empathy 
2. Clarifying facts 
3. What we don’t know  
4. Process to get answers 
5. Statement of commitment 
6. Referrals 

 
 

We are aware that an [accident/incident]______________________ involving 

 [type of incident]____________________________ occurred at approximately 

[time]______________, in the vicinity of [general location]________________.  

[Agency personnel]_________________________________ are responding,  

And we will have additional information available as we are able to confirm it.   

We will hold a briefing at [location]________________________________, and  

will notify the press at least [time, ie. ½ hour]____________________ prior to  

the briefing.  At this time, this briefing is the only place where officials authorized  

to speak about the incident and confirmed information will be available.   

Thank you for your assistance. 

 

Check message for: 
- Positive action steps 
- Honest / open tone 
- “We” not “I” 
- Be careful with early promises 

Avoid jargon 
Avoid judgmental phrases 
Avoid humor 
Avoid extreme speculation 

 

 

RELEASABLE INFORMATION 
- How many people involved / number and type of injuries / number of fatalities 
- What happened / type of accident or incident 
- When 
- Where / location of incident / property owner 
- Response Actions / identification of responding agencies 
Do NOT Release without Agency Administrator permission: 
- Names of Fatality Victims, including juveniles (only after next of kin are notified)  
- Names of Injured or Missing Victims  
- Names, ages, home units and hometowns of the individuals involved in the incident. 
- Crew names, aircraft characteristics or designators or other identifying info  
- Description of lost, stolen, or missing property. 
- Criminal charges if applicable. 
Do NOT Release:  
- Home Address, Phone, or Social Security Number 
- Names of Juveniles Charges with Criminal Offenses  
- Names of Victims of Sexual Assault  
- Names of people or witnesses who may become victims of crime or retaliation in the future 
- Information on incidents where criminal action is still under investigation and information 

released could hinder or adversely affect the investigation. 
- Investigative information beyond general incident reporting 
- Explicit details, including graphic photos or images of extreme injuries or brutal fatalities. 

- Provide information to victim/family first.  
- State only facts. Do NOT speculate. Confirm 

the obvious. 
- Document all individual actions on unit log. 
- Restrict radio communications. Share info via 

phone or face-to-face. 

 

http://emergency.cdc.gov/cerc/
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INCIDENT-WITHIN-AN-INCIDENT - FIRST MESSAGE 

Expression of empathy 

- This is an evolving emergency and I know that – just like we do – you want as much information 

as possible right now.  I wish I could answer all of your questions here.  While we work to get 

your questions answered as quickly as possible, I want to tell you what we can confirm right 

now. 

- Our ___________ (hearts / deepest condolences) go out to the _________ (firefighter’s last 

name) family and friends during this very tragic time.  

- ___________ (firefighter’s name) is a member of our __________ (agency) ‘family,’ and will be 

deeply missed.   

- He/she took on a difficult job, and served our nation well, in the finest tradition of the 

_________ (agency). His/her through his/her dedication, courage, and spirit – will live on in the 

hearts and minds of all of us.  

- Our thoughts and prayers are with _______ firefighter’s name) family, friends, and co-workers. 

 

Clarifying facts (VERIFIED facts only, skip if not certain) 

- On ____ (date) firefighter _________ (name), an _______ (age)-year-old _________ (agency) 

firefighter based out of __________ (home unit) in ___ (state) ________________ (describe 

situation - received multiple injuries yesterday, was killed while ____________ (clearing trees, 

etc.) while working on the _______ (fire name) fire on the ___________ (unit name) in 

___________ (state).  

- We are extremely relieved that no one was apparently injured in this incident  

- The crew has been taken off the fire pending investigation into the incident. 

- It is with great sadness that we confirm the names of the __________ (agency) firefighters who 

tragically lost their lives while in the line of duty _________ (when). 

 

What we don’t know 

- At this point, we do not know _________________ (# of injuries, # of deaths, cause of 

accident, etc.) 

- All of our efforts are directed at bringing the situation under control, so I’m not going to 

speculate about the cause of the incident. 

 

Process to get answers 

- We have a system (plan, procedure, operation) in place for emergencies such as this and we 

are being assisted by _______ (Sherriff’s Dept. etc.) as part of that plan. 

- We’ve just learned about the situation and are trying to get more complete information now.   

- The accident investigation is ongoing. 

- ____ (park mangers, etc.) are working with _____ (Sherriff’s Dept, etc.) to ensure site safety 

and integrity.  

- The ___________ (DOI’s Aviation Management Directorate, etc.) will participate in the crash 

investigation, which is being coordinated with the ____ (National Transportation Safety Board, 

Federal Aviation Administration, etc.).  

- An interagency (DOI, Contractor, FAA, Serious Accident Investigation Team, etc) investigation 

team is scheduled to arrive in _______ (location) ______ (when) to conduct a review of the 

incident. 



49 

 

 

Statement of commitment 

- The situation is ________ (under, not yet under) control and we are working with _______ 

(local, state, federal) authorities to (contain this situation, determine _____ (how this happened, 

determine what actions may be needed by individuals and the community to prevent this from 

happening again.) 

- Whenever injuries such as these occur during firefighting operations, a top priority is to learn 

everything we can about them so we can work to prevent similar incidents from happening 

again. 

- People are our most valuable resource and we remain committed to the safety of our 

firefighters. We cannot forget that there are still _____ (number) firefighters continuing to work 

to suppress fires here in _______ (location). We’ve made great progress but much remains to 

be done.  

- Our interagency fire teams develop strategies for fighting a fire. Fire managers continue to 

consider fire behavior, weather forecasts, terrain, accessibility and proximity to communities 

when considering fire suppression strategies.  

- We must consider firefighter safety in all of our tactical decisions. Firefighter and public safety 

will remain our number one concern. 

- As a precaution, all ____________ (aviation, etc.) operations on the __________ (home unit, 

etc.) are discontinued until further notice. 

 

Referrals (if possible, skip if not yet ready)  

- We will continue to gather information and release it to you as soon as possible.  I will be back 

to you within ___________ (amount of time, 2 hours or less), to give you an update.  As soon 

as we have more confirmed information, it will be provided.  We ask for your patience as we 

respond to this emergency.  For more information…  

- The name will be released by the ____________ Sheriff’s Department pending notification of 

family members.   

- Next scheduled update… 

- Calls on this incident will be taken starting at 0800 tomorrow morning (date) at the following 

numbers: ___________. 

- How can I reach you when I have more information? 

- I’m not the authority on this subject.  Let me have ______________ (name) call you right back. 

- We’re preparing a statement on that now.  Can I fax it to you in about two hours? 

- You may check our web site for background information and I will fax/e-mail you with the time 

of our next update. 

- Photographs will be made available as soon as possible at _________________________.  

- A fund will be established by the Wildland Firefighter Foundation in ____________________ 

(firefighter’s name) name. The foundation is online at http://wffoundation.org/ and can be 

contacted by calling 877-336-2950. 

 

http://wffoundation.org/
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INCIDENT-WITHIN-AN-INCIDENT FACTS 

BOLD CAPS = RELEASABLE INFO / All other info DO NOT RELEASE without AA approval. 

 
INITIAL REPORT BY:   TO WHOM:   DATE/TIME:  

# PERSONNEL INVOLVED: ` # VEHICLES:   # INJURIES:   

# FATALITIES:   # OK:  

WHAT WERE THEY DOING AT THE TIME?  

RESPONSE RESOURCES:      RESPONSE TIME:  

RESPONSE ACTIONS:  

FIRE NAME:     IMT/IC:  
 
HOME UNIT:     LOCATION/STATE:  
 
CAUSE:     START DATE: 
 
# PERSONNEL:    FUELS: 
 
TERRAIN:    WEATHER: 

Name:     Age:    Fireline Position: 
 
TRANSPORT:    HOSPITAL:  LOCATION:  
 
HOSPITAL PAO NAME & PHONE: 
 
INJURIES:   Treatment:  Cause of Death: 
 
Affiliation:    # Members:   Location:  
 
Home Unit:   Agency:     State:  
 
Hometown:   Yrs in Fire: 

EQUIPMENT TYPE:  Name:    Make/Model: 

Damage:    Driver/Pilot:    

TOTAL # ONBOARD:   Names Onboard:  

 

Description of lost, stolen, or missing property: 
 
Criminal charges: 



51 

 

PASSWORDS 

 
Disclaimer While the goal is to make this information as timely and accurate as possible, there 
are no claims, promises, or guarantees about the accuracy, completeness, or adequacy of the 
contents of this document. Liability for errors and omissions in the contents of this document is 
expressly disclaimed.  No warranty of any kind, implied, expressed, or statutory, including but not 
limited to the warranties of non-infringement of third party rights, title, merchantability, fitness for a 
particular purpose or freedom from computer virus, is given with respect to the contents of this 
document or its links to other Internet resources. Reference in this document to any specific 
commercial product, process, or service, or the use of any trade, firm or corporation name 
represent examples for information and convenience and does not constitute endorsement, 
recommendation, or favoring.  

WEBSITE USERNAME PASSWORD 

NAP - https://nap.nwcg.gov/NAP/ 
FAQ – Resetting Password, etc. 
http://ross.nwcg.gov/user_support/NAP.html 

  

Inciweb https://inciweb.nwcg.gov/  
Training / FAQ: https://bitly.com/Inciweb 

  

ROSS Self-Status 
https://bit.ly/ROSSSelfStatus 

  

FAMWeb https://fam.nwcg.gov/fam-web/ 
How To Access https://bit.ly/HowToFAMWeb 

  

WFDSS  http://wfdss.usgs.gov    

NIFC FTP - Incident Maps  

https://ftp.nifc.gov/public/incident_specific_data/ 

  

Firenet – Incident E-mail & Team Drive 
https://sites.google.com/a/firenet.gov/firenet 

  

   

   

   

   

   

   

   

   

   

   

   

   

   

https://nap.nwcg.gov/NAP/
http://ross.nwcg.gov/user_support/NAP.html
https://inciweb.nwcg.gov/
https://bitly.com/Inciweb
http://bit.ly/ROSSSelfStatus
https://fam.nwcg.gov/fam-web/
http://bit.ly/HowToFAMWeb
http://wfdss.usgs.gov/

